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Introduction
Introduction
Increasingly, new developments in ARCHICAD emphasize effective collaboration between architects 
and other professionals such as structural and mechanical engineers. This collaboration requires 
reliable methods for sharing and storing building model information, design solutions and 
proposals; it also requires a way to manage all the changes made to the building model by any of 
the participants, while also minimizing the possibility for human error.

ARCHICAD supports all major model and data exchange formats and some specialized formats, 
including intelligent 3D modeling, universal 2D drawing, documentation and image formats.
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Typical Workflow
Typical Workflow
This section is a general description of the typical issues to consider if you plan to exchange data 
between ARCHICAD and a Structural application.

For more details, see also Detailed Workflows: Architectural-Structural.

Structural applications can be divided into the following main categories:

• Analysis and design applications

These applications carry out and document static and design (steel, reinforced concrete, timber 
etc.) calculations based on various techniques (such as finite element method).

• Structural Preparation/Management

These carry out preparatory tasks and ensure the connection between the analysis application 
and the architectural profession.

• Detailers

These create detailed construction documentation of the structure (steel, reinforced concrete, 
precast, etc.) and communicate with the manufacturers.

Some applications cover several of these functions.

This diagram describes the general workflow for data exchange between ARCHICAD and a structural 
application:

The most complete level of interoperability is achieved using an intelligent 3D model connection - 
as opposed to a drawing representation - in which the building model being exchanged represents 
3D structural objects (slabs, walls, columns, beams, roofs etc.), each with specific, defined 
attributes and properties.

Model-based exchange between the architect and the structural engineer can follow one of two 
concepts: 

• managing a reference model; or

• converting the model to native formats.
Interoperability with Structural Disciplines 5



Typical Workflow
The reference model concept ensures the “security” of the architectural model and the structural 
model files, since each office remains responsible for his/her own model. Thus, the structural 
engineer receives a file from the architect, but does not modify it; he/she uses the architectural 
information as a basis for building up his own structural model. This occurs manually, using the 
tools of his own software, but automatic element conversion utilities also exist to speed up the 
process. Similarly, the architect leaves intact the file received from the structural engineer, while 
taking into account its suggestions for modeling load-bearing elements. This way, each discipline’s 
own file is independent of the one received as a reference.

This is often a sensible workflow, given that the architect’s model differs from that of the engineer. 
For example, when modeling a multi-story building, the architect might base the initial design on a 
multi-story column that runs through all the stories, whereas the structural engineer might put a 
separate column on each story. In another example, the architect would use a single slab to model 
an area for which the engineer or detailer would use hollow-core slab elements.

The other approach to model-based exchange is to convert the other party’s model elements into 
the native format of one’s own application. The converted model is transformed according to the 
specifications of the recipient, so the original version of the model is not preserved. This approach 
is most typical of data exchange between architectural and analysis programs.

See also Analysis Applications, below.

ARCHICAD can combine the advantages of both approaches. The 3D model obtained from the 
structural engineer - regardless of the method used to import it - is always transformed into native 
ARCHICAD elements. At the same time, it is possible to use the imported elements as a reference, 
since they can be automatically placed onto their own, protected layers (which are locked to 
prevent editing). This reference-model approach is also supported by the Merge and Link 
workflows.

See Merge vs. Link vs. Open.

Since the incoming elements or modifications are converted into native format, they become an 
active part of the architectural model, while retaining their properties (e.g. material, profile) 
assigned in the structural model.

The 3D models exchanged between the architectural and structural disciplines can be considered in 
three categories:

• Architectural model,

• Structural model,

• Analysis model.
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Typical Workflow
The architect works on the architectural model, based on her own design and on the client’s 
requirements. Already during the design phase, the architect should keep in mind that the model 
will later be exchanged with a structural engineer.

See Prepare Architectural Model for Export.

For example, she can define the building elements’ structural function; define initial materials to be 
used; choose columns and beams with standard profiles; define the load-bearing core of composite 
elements.

See Classification.

In addition to this preparatory work, she can filter the model so as to narrow down the data to be 
exchanged: this way, only the structural model, containing just structural elements, will be 
exported. Naturally, the architect can export the entire architectural model, if the structural 
engineer’s program is capable of filtering and collecting the model data that he/she needs to work 
with.

Exporting a structural model from ARCHICAD is sufficient for data exchange with most structural 
applications (the “management” and “detailer” types). However, analysis and design softwares 
require the so-called Analysis model in order to run their calculations. These applications can often 
convert the structural model to Analysis model themselves, or they can use the Analysis model 
converted by a management/detailer program as the input.

An Analysis model is a 2D or 3D representation of the structural model that includes not only planes 
(in the case of wall, slab, roof elements) and axes (columns and beams) of elements, but also their 
structural characteristics (e.g. stiffness, material, profile). The simplified analysis model also differs 
geometrically from the structural model: for example, curved surfaces are represented as a 
collection of planes; element intersections may be modified.

The export and import of 3D model data often takes place using a standard known as IFC (Industry 
Foundation Classes), which is actively supported by many design applications. In addition, many 
applications provide native Add-Ons for data exchange with other specific programs.

IFC-based data exchange can be enhanced by using the so-called BIM Collaboration Format (BCF)-
based communication. In this workflow, you can assign comment topics to IFC model elements. 
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Based on these, the other user can easily locate the referenced elements in the IFC model. BCF-
based data exchange is particularly suited for identifying overlaps (e.g. collisions, modeling and 
other mistakes) when several models from different applications are combined in one program (e.g. 
ARCHICAD or a model checker).

Some engineers or applications (especially analysis applications) will just exchange data at the most 
basic level: they import CAD drawings (that is, the lines and points representing floor plans, sections 
and elevations), and use them as a reference for building the analysis model.

See CAD Drawings for more details.

Models and drawings are often accompanied by other documentation, such as suggestions or 
reports; the most commonly used format for these is PDF.

ARCHICAD contains a number of techniques for displaying the structural model and for 
differentiating it from the architectural design.

See Visualization of Imported Content.

In addition, ARCHICAD can interpret and store the imported structural data, such as the proposed 
or utilized materials, and the properties of profile elements.

See Imported Properties.

Consultation and data exchange between structural and architectural offices generally requires 
several “round trips”. ARCHICAD’s Trace and Reference tool and a model-based change 
management feature helps to keep this process transparent.

This general architectural-structural workflow is explained in greater detail via the example 
workflows described below, which involve the interchange of model data between ARCHICAD and 
selected structural applications.
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Export Data from ARCHICAD
These sections provide detailed information on preparing your ARCHICAD model for export.

Prepare Architectural Model for Export
Recommended Export Formats
Interoperability with Structural Disciplines 9
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Prepare Architectural Model for Export
Partner offices usually do not require the fully detailed architectural model; a simplified model is 
sufficient. For example, Structural models are simplified versions of architectural models, which 
contain only the load-bearing building elements such as columns, beams, slabs, walls, roofs, and 
the load-bearing (core) parts of composite structures. If an architect plans to exchange models with 
a structural engineer, he/she should keep these requirements in mind when carrying out their 
design work, to make the eventual model exchange easier.

Classification
Connection between ARCHICAD Model and IFC Data
Using Standard Profiles with Structural Applications
Layer System
Filtering by Element Representation
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Classification

In ARCHICAD, you can optionally assign one or more classifications to any project element. A 
classification makes parameters and functions available to these elements for use by other 
applications: to organize project data, to make models transparent, to locate elements, for listing 
purposes, to share exact data, etc.

For each construction element, classifications can be set in the Classification and Properties panel 
of its Settings dialog box.

The following classification and category definitions are relevant for data exchange using IFC:

Element Classifications

ARCHICAD provides a flexible way to classify elements according to any national or company 
standard classification system. You can assign one Classification value per Classification System in 
the Elements’ Settings dialog, or from the Interactive Schedule.

Element classification affects the IFC export process: each element will be saved to the IFC model 
according to an IFC Type. This is displayed in the “IFC Type” item in the Classification and Properties 
panel (under IFC Properties). Thus, if you classify a slab as a ceiling in ARCHICAD, the target program 
will interpret this element as a ceiling.

Note: The IFC Type Mapping of ARCHICAD elements by classification depends on the Type 
Mapping for Export setting of the current IFC Preview Translator. 
Interoperability with Structural Disciplines 11
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Structural Function Category for IFC

“Load-Bearing Element” or “Non-Load-Bearing Element”

In collaborating with partners who are using structural programs, you can export your ARCHICAD 
model to IFC format: the Structural Function classification (assigned in ARCHICAD) automatically 
adds the “load-bearing” property to structural elements in the export file.

Note: By default, Revit Structure will display only walls that have the “load-bearing” property in 
the “Structural” discipline views. But, if you forget to classify required walls as “Load-Bearing 
Elements” in ARCHICAD, the structural engineers can also change the bearing function of walls, 
or they can apply another display discipline (e.g. “Architectural”) in order to show all walls 
exported from ARCHICAD.

The current IFC standard supports the export of the “load-bearing” IFC property only for the 
following elements: Wall, Slab, Column, Beam, Roof; elements classified as such in ARCHICAD; 
and objects having these sub-types.

If you have classified model elements as “Load-Bearing Elements”, then you can use the Partial 
Structure Display “Core of Load-Bearing Elements Only” option to display those elements only. This 
is particularly useful if you wish to export only load-bearing elements to a structural engineer: in 
this case, just use the “visible elements” export mode on a view that uses this Partial Structure 
Display option. 

This category is useful for listing purposes - for example, you can calculate the materials needed for 
all load-bearing walls or columns, separately from materials of non-load-bearing elements. 

Criteria in the Find & Select dialog box include: search for those elements that have been defined as 
load-bearing or non-load-bearing, or whose Structural Function category is “Undefined”. Since IFC 
export can be limited to selected elements only, you can - for example - export all selected elements 
defined load-bearing (not just their Core only, as described in the example above).

The load-bearing data is also a standard property of exported elements. Moreover, if other 
applications (such as a structural program) also categorize elements according to their load-bearing 
function, ARCHICAD can filter these elements upon importing them, and such elements will show 
up in the ARCHICAD model with that classification.

Position Category for IFC

“Interior” or “Exterior”

This category is useful if you plan to send an IFC file to partners (e.g. energy analyzers) who are able 
to differentiate elements by their location in the building. When you export the ARCHICAD model to 
IFC format, your model elements that are classified as “Interior” or “Exterior” will carry this 
information to the partner’s application via IFC.

Naturally, the opposite is also true. Since Position (IsExternal) is a standard IFC property for certain 
building elements (e.g. Wall, Slab, Column, or Beam), if an imported IFC model contains such data, 
then the appropriate category is automatically added to the respective elements.

Criteria in the Find & Select dialog box include: search for elements categorized as either “Exterior” 
or “Interior”, or whose position is “Undefined”.

Interactive Schedule Criteria are also available to differentiate listed elements by Position.
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Note: Within ARCHICAD, the Position category is fully usable as an ARCHICAD property (e.g. in 
Find & Select and Interactive Schedule). However, it will not be exported as an IFC property for 
certain element types (e.g. Ceiling (IfcCovering)) which are not supported by the IFC standard.
Interoperability with Structural Disciplines 13
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Connection between ARCHICAD Model and IFC Data

All IFC data behave as native ARCHICAD data: every operation involving ARCHICAD data is available 
as IFC data.

Since the IFC properties are native to ARCHICAD, the following functions are available:

• Assign, edit and view IFC properties in the Manage IFC Properties dialog box, accessible from the 
element Settings dialogs (Classification and Properties panel).

• Use the Find & Select command to search for the IFC properties of any element.
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• Use Interactive Element Schedule to list the IFC properties of any element.

• You can use the Pick up/Inject Parameters shortcuts and Copy-Paste to transfer IFC properties 
from one element to another.

•  IFC properties are included in the settings of elements saved as Favorites. Thus, you can use 
these Favorite elements (together with their IFC properties) in different ARCHICAD projects.

• Data (including IFC data) defined in the Classification and Properties panel of element settings 
can be displayed in ARCHICAD, by showing these data in Labels, Zone Stamps and Markers.
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• The IFC content of Hotlink Modules can be queried and listed.

• In Teamwork, IFC data can be modified for elements that you have reserved.

• The IFC data of elements are accessible through the ODBC driver and the ARCHICAD API (Add-Ons 
that can be developed for ARCHICAD). Use the IFC Project Manager to manage all IFC data related 
to the project (including that of Hotlinked Modules). You can navigate easily between the model 
elements and the data listed in the Manager, both from the Floor Plan and from 3D views.
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• All ARCHICAD tool parameters (element properties, Interactive Element Schedule (IES) data, 
Library Part parameters, etc.) can be mapped to IFC standard or custom properties based on 
conversion rules, defined in the IFC Translator for Export. 

• When assigning IFC properties to elements, you should naturally choose the parameters that 
the receiving application is capable of reading, displaying or querying. Thus it is worthwhile to 
consult with the engineer or other professional to whom you plan to send the data. 
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Using Standard Profiles with Structural Applications

If you exchange data with structural applications, it can be helpful to use standard elements as your 
steel profiled Columns or Beams. During the data exchange process, numerous structural 
engineering programs are able to recognize and identify such standard elements accurately and 
completely.

In ARCHICAD, the Options > Complex Profiles > Import Standard Steel Profile command brings up 
the Profile Database, from which you can import profile shapes and sizes, which are listed by their 
country-specific code numbers.

Hint: Standard profiles can serve as the basis for creating additional, standard-shaped (e.g. I-
shaped) profiles that have a custom name or additional details (such as a fillet radius) - use the 
Profile Manager to duplicate and edit a standard profile.
Interoperability with Structural Disciplines 18



Export Data from ARCHICAD
Layer System

ARCHICAD’s layer system (Layers and Layer Combinations) can help in narrowing down the parts of 
the model to be exported. Use layers to group elements conceptually (e.g. structural elements) and 
to separate them from elements not needed in the exported model (e.g. furniture). For example, 
you can choose filters that will export only elements located on layers set to “visible”, while you 
hide the layers of the elements you do not need to export.

Note: Naturally, layers are also exported as standard IFC entities assigned to elements. The 
receiving application may display this data or perhaps use it to filter elements; this depends on 
the particular application. For example, Tekla Structures can filter reference model elements 
based on layers exported from ARCHICAD.
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Filtering by Element Representation

Since the export always considers the display settings of the current exported view, you can further 
filter the model according to the elements’ display status:

Note: The following display options can vary depending on the view. Keep in mind that IFC 
export will consider the display options that were in effect for the particular view from which 
the export command was issued.

Partial Structure Display

The Partial Structure Display function allows you to display or hide the model’s complex or 
composite components, depending on their type or classification. For example, when collaborating 
with other designers or engineers, you may prefer to ignore non-load-bearing walls, and to display/
output only the load-bearing components of complex elements.

The first three options display or hide the components of composite or complex elements, 
depending upon how you have defined those components. For example, choosing “Core Only” 
displays only the load-bearing skin of the complex or composite structures.

“Core of Load-Bearing Elements Only” considers all construction elements (not just composite/
complex), and enables you to hide any elements you have classified as “Non-Load-Bearing 
Elements” or “Undefined”.
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See Classification.

It displays all elements classified as “Load-Bearing Elements”. Load-bearing composite and complex 
elements are displayed with their Core only.

The Veneer part of Columns can be displayed or hidden by Partial Structure Display according to its 
type: “Core”, “Finish” or “Other”.

Window/Door Representation

In exporting models with windows/doors/skylights, you should consider whether the recipient of 
the model data really needs all the detailed geometrical parameters (frames, glass) associated with 
the openings, or whether exporting just the openings themselves might be enough (as when 
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exporting for analysis programs). Element visibility can be defined using the following ARCHICAD 
controls: 

Floor plans

Document > Model View > Model View Options: Options for Construction Elements > Door/
Window/Skylight Options.

3D Views

View > Elements in 3D View > Filter and Cut Elements in 3D: Element Types to Show in 3D 
(Window/Door/Skylight).
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Recommended Export Formats
The following pages provide an overview of the main export formats available from ARCHICAD.

IFC Model-Based Connection

The principal benefit of IFC (Industry Foundation Classes) object-oriented file format is its object 
description. Not only does the IFC protocol preserve the full geometric description in 3D, but it also 
knows object location and relationships, as well as all the properties (or parameters) of each object. 
With IFC input/output, ARCHICAD can communicate with a wide range of structural, mechanical 
and energy analysis applications.

It is important to consider what type of information should be exported to the different disciplines. 
For example, structural engineers will want the load-bearing parts of the building, while an HVAC 
consultant will need a richer model with more internal information. Besides preparation (described 
above), ARCHICAD’s IFC interface enables you to filter the building information model before 
exporting it.

See Prepare Architectural Model for Export.

Predefined (but customizable) Translators help you apply IFC model exchange settings as simply as 
possible, providing “one-click” export/import solutions.

After exporting an IFC model, it is good practice to check the IFC model in an IFC viewer. There are 
many free IFC viewers on the market that can be readily downloaded:

• DDS-CAD Viewer: http://www.dds-cad.net

• Solibri Model Viewer: http://www.solibri.com

• Tekla BIMsight: http://www.teklabimsight.com

IFC-based data exchange can be enhanced by using the so-called BIM Collaboration Format (BCF)-
based communication. When several IFC models from various professions are combined in one 
project, the BCF workflow enables participants to add comments to the overlapping issues (e.g. 
collisions). BCF comments include the referenced IFC elements’ GUIDs and an attached preview 
(snapshot) picture; these enable users to easily locate the “problematic” model elements in the 
referenced view, using the same exact camera position as the snapshot. ARCHICAD’s Mark-Up tool 
supports BCF commenting, import and export. Many professional software programs and the many 
of the viewers listed above have implemented BCF. 
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Export Data from ARCHICAD
Direct Model Link

Another way to export a model is to use the direct link between ARCHICAD and another software 
application. This means that a specific Add-On (developed by other applications for use with 
ARCHICAD) converts the ARCHICAD elements (e.g. the structural elements) to the corresponding 
elements of the connected application. This exchange mode also ensures that only those properties 
needed by the target application are included in the resulting model file.

Ask your partner if his/her application has an available Add-On for ARCHICAD.

CAD Drawings

Despite their increased reliance on model-based data exchange, architects and engineers still rely 
on each other’s CAD drawings to use as a reference in their respective models.

Because file format compatibility is crucial when working with outside consultants, or when 
upgrading from another CAD system, ARCHICAD provides the functionality to ensure an accurate 
conversion process.

ARCHICAD’s DXF/DWG translator supports formats up to AutoCAD 2017 and accurately maps layers, 
pen colors, fonts and blocks. ARCHICAD can write out DXF/DWG data that contains both Paper 
Space and Model Space information in the same file. ARCHICAD’s intelligent handling of AutoCAD 
XREFs, at input and output, not only preserves the link but allows XREF administration (including 
linking, unlinking and binding) within ARCHICAD.
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When you provide your consultants with digital files for modification, ARCHICAD’s DXF/DWG Merge 
Engine ensures a “clean” file. User-defined rules eliminate conflicts, giving you control over how 
changes are merged with the Virtual Building model.

Additionally, ARCHICAD imports and exports AutoCAD’s vectorial DWF format and MicroStation’s 
DGN.

PDF Output

Adobe’s Portable Document Format (PDF) has become the most popular digital file format for 
publishing and archiving the architectural documentation. ARCHICAD’s internal PDF engine 
supports both the export and import of PDF documents, including PDF/A format. Importing PDF 
documents as drawings is a great way to bring in a standard detail or manufacturer’s specifications 
directly onto an ARCHICAD layout sheet or Worksheet.
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Import Data to ARCHICAD
The following sections provide information on what to consider when importing data from other 
programs to ARCHICAD. 

ARCHICAD imports all file formats - IFC models, CAD drawings and PDF files - listed in the Export 
section.

Merge vs. Link vs. Open
Visualization of Imported Content
Imported Properties
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Merge vs. Link vs. Open
The possible ways of using the model data, CAD drawings and reports received from another 
application in ARCHICAD are the following:

Merge

Use Merge to add the model or drawing content (or part of it) to the currently running ARCHICAD 
project. Merged model data are converted into native ARCHICAD elements, which can then be used 
as a protected or editable reference. The imported content, used as a reference, is separated from 
the host project elements, and can be displayed together or independently from the original project 
data by choosing a visualization technique.

See Visualization of Imported Content.

Merged IFC data are converted to native ARCHICAD properties, so they can be searched, listed, and 
used in the model.

The Detect IFC Model Changes command applies the merging algorithm for the detected 
geometrical differences between two (old and new) states of received models (two IFC files 
exported from the same application).

Note: Before merging a file, you should save the running ARCHICAD file.

Link

As another “reference” possibility, you can directly hotlink any IFC file to an ARCHICAD host project, 
managing it like other Hotlink Modules. Hotlinked IFC content is imported using an IFC Translator for 
Import, saved within a template file, so that you can maintain control over the attributes of the 
Hotlink Module file.

CAD drawings and reports (PDF) can be directly linked to the current ARCHICAD project. Depending 
on the file formats, use XREF and/or Drawing connection.

Open

The Open command launches a model or CAD drawing as a separate ARCHICAD file, independent of 
any other project currently open in ARCHICAD. 
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Visualization of Imported Content
ARCHICAD offers a number of visualization tools that make it easy to find and view the imported 
content within ARCHICAD, and, if needed, to differentiate it from the architectural model.

Layer Display Modes
Trace & Reference

Layer Display Modes

To differentiate elements from the original ARCHICAD elements, place them onto a separate layer.

Note: You can set ARCHICAD to do this automatically as part of the merge process, using the 
appropriate control of the IFC Translators dialog box.

In 3D Views, you can use layer settings to display imported structural and mechanical elements 
differently from architectural elements. For example, set the 3D View Display mode of architectural 
layers to Wireframe, while applying Shading mode for all imported element layers.

Trace & Reference

ARCHICAD views can also be used to differentiate elements of different disciplines. For example, 
create some views showing architectural elements, and other views that show the structural/
mechanical elements only.

If you activate an architectural view, you can then use the Trace & Reference feature to view a 
structural/mechanical view at the same time – differentiated by highlighting or colors, or splitting 
the views apart on screen.
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Imported Properties
When importing model-based data using IFC, the imported data will include not just the geometry 
of the elements, but also many of their parameters.

The most important general IFC properties will be interpreted as ARCHICAD attributes. These 
include, for example, construction materials (e.g. the steel quality of a column, represented in 
ARCHICAD by a Building Material), composites, profiles, presentation styles (as ARCHICAD Surface), 
and layers.

IFC properties imported from an IFC model become part of the running ARCHICAD project and will 
be considered native ARCHICAD properties. Certain of these IFC properties have exact counterparts 
as ARCHICAD parameters - for example, Structural Function and Position.

See Classification.

Other IFC data will appear as standard or custom IFC properties in the element’s Settings dialog box 
and, for the model as a whole, in IFC Project Manager.

Since the IFC properties are native to ARCHICAD, the following functions are available:

• Assign, edit and view IFC properties in the Manage IFC Properties dialog, accessible from the 
element Settings dialogs (Classification and Properties panel).

• Use the Find & Select command to search for the IFC properties of any element.

• Use Interactive Element Schedule to list the IFC properties of any element.

• Use the Label tool to show IFC properties of any element in the ARCHICAD window.

• You can use the Pick up/Inject Parameters shortcuts and Copy-Paste to transfer IFC properties 
from one element to another.

• The IFC content of Hotlinked Modules can be queried and listed.

To see all the imported IFC properties of imported IFC models (Structural, MEP, etc.), use the IFC 
Project Manager. There, you can further filter the displayed properties by visible layer: this way, you 
can show only the properties of a particular IFC model, or just part of the model. The structure of 
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the IFC Project Manager enables you to easily navigate among elements, which can be listed either 
by type or by containment structure, and selected in the Floor Plan or 3D Window.
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Detailed Workflows: Architectural-Structural
This section describes the recommended workflow for data exchange with selected structural 
applications.

Tekla Structures
Autodesk Revit (Structure)
Analysis Applications
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Tekla Structures
Tekla Structures is a Building Information Modeling (BIM) software that enables the creation and 
management of accurately detailed, highly constructible 3D structural models regardless of 
material or structural complexity. Tekla models can be used throughout the entire building process 
from conceptual design to fabrication, building and construction management.

Read more about Tekla Structures at http://www.tekla.com.

In addition to IFC, BCF-based issue management (e.g. clash detection, property changes, etc.) can 
be carried out between Tekla Structures and ARCHICAD, as both of the applications support BCF as 
a native function.

Here, we describe the proposed workflow for architectural-structural model exchange between 
ARCHICAD and Tekla Structures. The suggested exchange data format is the model-based IFC 
version 2x3.

Note: To see a video (narrated in English) of the recommended ARCHICAD-Tekla Structures 
workflow and its options, based on a real example, go to:
http://www.graphisoft.com/archicad/open_bim/structural_workflows/

Then scroll to: ARCHICAD-Tekla Structures Workflow.

Step 1: Model Export from ARCHICAD

Let’s start with the architectural model: architects create the first model according to the client’s 
request and the given site.
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Detailed Workflows: Architectural-Structural
When building the architectural model, you should keep in mind that you plan to share it with a 
structural engineer. Thus, use the classification and category options in ARCHICAD to differentiate 
load-bearing elements, place elements onto special layers, and/or define the initial profile and 
materials of the elements, such as steel bar (column and beam) elements.

If you prepare your architectural model this way, then all you have to do when exporting it to IFC is 
to apply certain filters. Moreover, among the export options, you can choose “Export all visible 
elements”, which is another way to filter the elements for export: for example, use ARCHICAD’s 
Partial Structure Display function so that only the cores of composite elements are visible, or use 
Model View Options to display and thereby to export the opening only, without the frame details 
and other unneeded data.

See Prepare Architectural Model for Export.

ARCHICAD offers a built-in translator whose settings are optimized to export models to Tekla 
Structures via IFC (the name of this translator is “Tekla Structures Export”). Of course, you may 
define and fine-tune your own custom translators, based on your specific needs.

Other ways to filter elements during the export process:

• by elements’ visibility in the view from which the export is launched,

• by current element selection,

• by story (e.g. ground floor only),

• by element types (e.g. columns and beams only),

• by ARCHICAD Structural Function classification (e.g. “Load-Bearing elements only”),
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or you can export the whole project/building without any filtering. The default filtering rules of the 
translators can also be fine-tuned or modified manually as part of the export process (File > Save as 
(IFC)).

Note: You should not use this filter when importing a model from Tekla Structures (the “All 
elements” setting is recommended instead), because Tekla Structures does not differentiate 
between load-bearing and non-load bearing elements.

You can set model views for the Tekla Structures export that contain only the important (visible) 
elements you would like to share with the structural engineer, and then use Publisher to export all 
these view sets as IFC models, with one click.

Step 2: Model import into Tekla Structures

Engineers receive the model from the architect and insert it as a protected reference into a Tekla 
Structures project (“Insert reference model” tool). They can choose to import the entire content of 
the architectural model, or only the elements on selected architectural layers. This way, the 
structural engineer further filters the model if required.

Engineers define the structural model and its details based on the reference model and its element 
properties (materials, profiles) as defined by the architect. Tekla-type elements can be converted 
from the referenced architectural elements using Tekla’s “Convert IFC objects to native objects” 
tool; or they can be defined manually.

Tekla Structures can also generate analytical models from the structural model and share them with 
analysis applications. Based on the results of the analysis and design calculations, the structural 
model is finalized.

Step 3: Structural model export from Tekla Structures

The structural model or a filtered part of it can be exported back to ARCHICAD via an IFC file.

The following table, which summarizes the most essential Tekla Structures elements, shows that a 
highly detailed structural model can be imported into ARCHICAD.
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Step 4: Structural model import into ARCHICAD

Depending on the chosen import method, you can merge or link the structural model, or a part of 
it, into your running ARCHICAD project.

We recommend using the default IFC translator set for Tekla Structures Import. Of course, 
customized translator and filtering settings can also be applied.

Note: You should not filter elements by “Structural Function” when importing a model from 
Tekla Structures, because Tekla Structures does not differentiate between load-bearing and non-
load bearing elements in its model export; it does not support the “Load-Bearing” IFC property. 
Thus, the “All elements” option is the recommended and default Model Element Filter setting of 
the “Data Exchange with Tekla Structures” translator.

According to the default Tekla Structures Import IFC Translator, the imported elements are placed 
on locked layers with the extension “Tekla”, in accordance with the reference model concept.

Structural elements can be displayed together with the architectural model using ARCHICAD’s 
special visualization techniques. For example, you may visually compare the current model and the 
structural content as two different 2D views, using the Trace & Reference tool.

For more details, see Visualization of Imported Content

Architects can check the main structural as well as other additional properties by element (in the 
Settings dialog of the imported elements) or by model-hierarchy (using IFC Project Manager).

See Imported Properties.
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This import process (using the Tekla Structures Import IFC Translator) also contains material 
conversion, which maps the default Tekla Structures materials to ARCHICAD Building Materials, 
while preserving the original names of the imported materials. This also means that structural 
elements in section windows will be displayed with the cut fills of their assigned Building Materials. 
Of course, the mapping rules can be easily edited and expanded at IFC Translator settings.

Any unrecognized Tekla materials are displayed with a default chosen ARCHICAD Building Material.

Steps 5-6: Architectural model update

In ARCHICAD, you can manually update your project according to the imported model elements by 
using them as reference, or by copying and using the structural elements as real ARCHICAD-type 
elements, since they are native ARCHICAD elements, as a result of the automatic conversion that 
occurs with the import process. (These imported elements are locked by default.)

A new version of the architectural project can now be exported again via IFC as described earlier.

Steps 7-9: Change detection in Tekla Structures

Tekla Structures can insert the new IFC file next to the old one in the same structural project. A 
change manager can compare and display the geometrical changes between the two reference 
models. The new, deleted, changed and unchanged elements can be displayed alongside the real 
structural model.
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Next, engineers can make changes in the project according to the results of the comparison, and 
then send a new structural model version back to ARCHICAD.

Steps 10-11: Change detection in ARCHICAD

The new IFC model version received in ARCHICAD can be compared with the previous version, using 
the Detect IFC Model Changes command.

The result of the comparison is listed and displayed with the Mark-Up tool, and only the differences 
are merged into the current project. You can easily check the changes recommended by your 
structural partner, and make modifications on your current project manually, or by using structural 
elements as real ARCHICAD-type elements.

Step 12: Additional Data Exchange/Cycles

Both engineers and architects can repeat the previously mentioned model exchange, comparisons 
and updates in additional cycles. And finally, the two disciplines make their own or combined 
documentations.
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Autodesk Revit (Structure)
Autodesk Revit provides tools specific to structural design for structural engineering firms: it 
integrates a physical model with an independently editable analytical model for structural analysis, 
design, and documentation.

In addition to IFC, BCF-based issue management (e.g. clash detection, property changes, etc.) can 
be carried out between Revit and ARCHICAD. Revit supports the BCF workflows via 3rd party Add-
Ins such as BCF Manager, developed by Kubus.

Here, we describe the proposed workflow for architectural-structural model exchange between 
ARCHICAD and Revit (version 2010 or later). Although both softwares are able to handle CAD 
drawings, here we highlight the model-based data exchange via IFC (recommended version 2x3).

Note: To see a video (narrated in English) of the recommended ARCHICAD-Revit (Structure) 
workflow and its options, based on a real example, go to:
http://www.graphisoft.com/archicad/open_bim/structural_workflows/

Then scroll to: ARCHICAD-Revit Structure Workflow.

Step 1: Model export from ARCHICAD

Let’s start with the architectural model: architects create the first model according to the client’s 
request and the given site.
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Detailed Workflows: Architectural-Structural
When building the architectural model, you should keep in mind that you plan to share it with a 
structural engineer. For example, you can use the classification options in ARCHICAD to differentiate 
load-bearing elements, place elements onto special layers, and/or define the initial profile and 
materials of elements, for example steel bar (column and beam) elements.

Note: Revit is able to differentiate between “load-bearing” and “non-load-bearing” building 
elements (in element properties and by displaying disciplines). This information can be initially 
defined using ARCHICAD’s “Structural Function” classification, whose values are translated in 
the IFC file and can be recognized/handled in Revit as follows:

See Classification.

If you prepare your architectural model this way, then all you have to do when exporting it to IFC is 
to apply certain filters.

• You can use ARCHICAD’s Partial Structure Display function so that only the cores of composite 
elements are visible, or in case of Doors/Windows, use Model View Options to display and 
thereby to export openings only, without the frame details and other unneeded data.

See Prepare Architectural Model for Export.

• From IFC Save Options, you can choose “Export all Visible elements (on all stories)”, which is 
another way to filter the elements for export.

It is also advisable to include the grid-system (created by Grid Element and Grid System tools) in the 
IFC data, as the basis of reference for 3D element positioning.
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ARCHICAD offers a built-in translator (“Revit Structure Export”) whose settings are optimized to 
export models to Revit via IFC. Of course, you may define your own custom translators, based on 
your specific needs.

If the purpose of the exchange is merely to share a model’s exact geometry (that is, as a reference 
model, and not to generate native elements in Revit), then we suggest using the translator named 
“Revit Export for Reference Model.”

Other ways to filter elements during the export process:

• by elements’ visibility in the view from which the export is launched,

• by current element selection,

• by story (e.g. ground floor only),

• by element types (e.g. columns and beams only),

• by ARCHICAD Structural Function (e.g. “Load-Bearing elements only”),

or you can export the whole model without any filtering. The default filtering rules of the 
translators can also be fine-tuned or modified manually as part of the export process (File > Save as 
(IFC)).

Notes:

◦ In setting up the translator for Revit (Structure), you can take into consideration the 
Structural Function category of ARCHICAD elements. This means that if the translator’s 
Model Element Filter is set to “Load-Bearing elements only,” then only the elements 
classified as “Load-Bearing” in ARCHICAD will be exported.
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◦ Conversely, when importing from Revit, only elements categorized as “Bearing” in Revit will 
be imported into ARCHICAD. If there is no element-level load-bearing category assigned in 
ARCHICAD, or if you wish to import all elements from Revit (including non-load-bearing 
elements), then leave the translator’s Model Element Filter setting as “All elements”.

◦ If you would like to include 2D elements (like dimensions, texts, labels, lines, circles etc.) 
when exporting the 3D ARCHICAD model via IFC, you must enable this feature in the 
translator. 

◦ Use the IFC format in ARCHICAD’s Publisher to export the required views with just one click.

Step 2: Model import into Revit

Engineers receive the model from the architect and open its entire contents as a new Revit 
(Structure) project. The program converts all elements to Revit-type elements according to the 
applied IFC mapping table. Before importing an ARCHICAD model, the structural engineer can 
modify the default import settings that map IFC element types to Revit categories and 
subcategories.

Example: ARCHICAD Foundation-type Objects (IfcFooting) can be loaded into Revit as 
“Structural Foundation” elements instead of “Generic Model” elements.

Remember: Classification in ARCHICAD enables you to customize element-level conversion for 
the purposes of IFC export. For example, if you use the Wall tool to model a beam, you can 
export the (wall) element as a beam (IfcBeam) to Revit.

See Classification.

When the structural engineer imports an ARCHICAD IFC model, warning and/or error messages may 
appear about the limits of Revit’s capacity to read IFC data accurately (for example in importing 
ARCHICAD Zones and Grids). To help minimize these, GRAPHISOFT has developed a Revit Add-In, 
called GRAPHISOFT ARCHICAD Connection, whose “Improved IFC Import” function fixes a number 
of these known shortcomings of the standard open process.

See GRAPHISOFT ARCHICAD Connection.

After importing from ARCHICAD to Revit, certain imported element types will be hidden by default. 
This is not a data loss; the engineer must simply adjust some display settings for Revit Floor Plans 
and 3D Views.

Examples:

◦ Architectural walls imported to Revit (that is, walls which were set to either “Undefined” or 
“Non-Load-Bearing Element” in ARCHICAD) will be hidden in Revit’s “Structural” discipline 
view, so the structural engineer must change display settings in order to see these walls.

◦ Column, Stair, Roof, and Covering elements imported to Revit will be hidden by default in 3D 
Views. The structural engineer can easily unhide them using the Visibility/Graphic setting or 
tools such as the Reveal Hidden Elements command.

Engineers define the structural model and its details based on the imported model elements and 
their properties (materials, profiles…) assigned by the architect.

Note: When using the reference model concept, engineers can save the imported IFC model as a 
separate Revit file (RVT) and link it into a running Revit project as a reference to protect its 
content.
Interoperability with Structural Disciplines 42



Detailed Workflows: Architectural-Structural
Revit can also generate analytical models from the structural model and share them with analysis 
applications, which perform analysis and design calculations. Based on the results of the analysis 
and design calculations, the structural model is finalized.

Step 3: Structural model export from Revit

The structural model can be exported back to ARCHICAD via IFC.

Before exporting a Revit structural model to IFC, the structural engineer can modify the default IFC 
export settings that map generic family instances to IFC element types. For example, Structural 
Stiffeners can be exported as “IfcBeam”, which can then be used as real ARCHICAD Beams.

The GRAPHISOFT ARCHICAD Connection Add-In (with its Export to ARCHICAD function) is designed 
to fix the shortcomings of Revit’s IFC model export to ARCHICAD.

See GRAPHISOFT ARCHICAD Connection.

The following table shows the elements represented by Revit’s Structure basic tools, which 
generally make up the structural model. (This is just an indicative list of the basic Revit elements, 
but ARCHICAD imports all elements.)

Step 4: Structural model import into ARCHICAD

Depending on the chosen import method, you can merge or link the structural model, or a part of 
it, into your running project.

We recommend using the “Revit Structure Import” IFC translator. Of course, customized translator 
and filtering can also be applied.

Using the “Revit Structure Import” IFC translator, the imported elements are placed on locked layers 
in ARCHICAD, with the extension “Revit Structure”.
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Structural elements can be displayed together with the architectural model using ARCHICAD’s 
special visualization techniques. For example, you may visually compare the current model and the 
structural content as two different 2D views, using the Trace & Reference tool.

For more details, see Visualization of Imported Content.

Architects can check the main structural as well as other additional properties by element (in the 
Settings dialog of the imported elements) or by model-hierarchy (using IFC Project Manager).

Using the “Revit Structure Import” IFC translator, the import process also contains material 
conversion, which maps the default Revit structural materials to ARCHICAD Building Materials, 
while preserving the names of the original imported materials. Of course, the mapping rules can be 
easily edited and expanded at IFC Translator settings.

Any unrecognized Revit materials are displayed with a chosen default ARCHICAD Building Material.

Steps 5-6: Architectural model update

In ARCHICAD, you can manually update your project according to the imported model elements by 
using them as reference, or by copying and using the structural elements as real ARCHICAD-type 
elements, since they are native ARCHICAD elements, as a result of the automatic conversion that 
occurs with the import process. (These imported elements are locked by default.)

A new version of the architectural project can now be exported again via IFC as described earlier.
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Steps 7-10: Update models in Revit

Revit opens the new version of the architectural model as a new Revit project. If the structural 
engineer uses the “link concept”, he/she can easily update the previously linked architectural model 
(an RVT file saved from IFC) to the new one. Engineers make changes in the project according to the 
new architectural version, and then send a new structural model version back to ARCHICAD, using 
IFC.

Steps 11-12: Change detection in ARCHICAD

In ARCHICAD, the received new IFC model version can be compared with the previous version by 
using the Detect IFC Model Changes command.

The result of the comparison is listed and displayed with the Mark-Up tool; only the differences are 
merged into the current project. You can easily check the changes recommended by your structural 
partner, and make modifications to your current project manually, or by using structural elements 
as real ARCHICAD-type elements.

Step 13: Additional Data Exchange/Cycles

Both engineers and architects can repeat this process of model exchange, comparisons and updates 
in additional cycles. Finally, the two disciplines make their own or combined documentations.

GRAPHISOFT ARCHICAD Connection

The GRAPHISOFT ARCHICAD Connection is a free Add-In for Revit (version 2010 or later; 32- and 64-
bit). The Add-In improves the IFC model-based data exchange between Revit applications and 
ARCHICAD:

Functions

GRAPHISOFT ARCHICAD Connection has two commands. The Improved IFC Import command post-
processes a previously converted (imported) IFC file in Revit and fixes a number of Revit’s known 
shortcomings in IFC model conversion. The Export to ARCHICAD command directly exports and 
optimizes the IFC model data for use in ARCHICAD. ARCHICAD Connection has the following 
additional functions:

• Direct import and export of IFC 2x3 (*.ifc and *.ifczip) files

• Mapping of Revit Phasing to ARCHICAD Renovation Status 

• Set Project Information using IFC Project data

• Correction of True North settings

• Conversion of Structural Floor elements - Improved import of IFC Spaces

• Import of all IFC parameters as schedulable Revit parameters

• Auto-Join Elements

• Export of True North data
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• Export of Grid elements

• Customizable export options:

◦ Phase to export

◦ Export only elements visible in view

◦ Export annotation elements

◦ Split walls and columns by level

◦ Export parts as building elements

◦ Export internal IFC property sets

◦ Export schedules as property sets

◦ Export Family and Type name as Reference property

Notes:

◦ The installer of the GRAPHISOFT ARCHICAD Connection Add-In can be downloaded free from 
the following site:
http://www.graphisoft.com/support/archicad/downloads/interoperability.

◦ Although IFC4 is already supported by ARCHICAD and Revit, IFC2x3 is the recommended 
version. 
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Analysis Applications
A wide variety of analysis applications are used in different countries, which handle architectural 
models from ARCHICAD in different ways:

1. Some applications can open the IFC model from ARCHICAD, and then use it either as a reference 
model (placed on a protected layer), or convert it into a 2D or 3D Analysis model consisting of 
calculable lines and planes.

2. Other applications import the architectural floor plans, sections and elevations as reference 
drawings in formats such as DWG, then manually create an Analysis model.

3. Yet other applications import the architectural model via a third program - for example, they use 
Tekla Structures or Revit Structure to convert the architectural/structural model into an analysis 
model, and then import this analysis model, rather than importing the architectural model.

Whether using IFC or DWG format to exchange data with analysis applications, it is recommended 
to narrow the architectural model to just the data needed by the engineer, and to use the 
translators, either predefined or custom. In the case of IFC, ARCHICAD includes predefined IFC 
Translators for importing and exporting to analysis programs, but naturally that can also be 
customized as needed, or new translators created.

See Prepare Architectural Model for Export.

For example, depending on the capabilities of the host structural application, you may wish to 
adjust the IFC Translator to enable support for grid-system export, which you may want to include in 
the IFC data to serve as a reference for 3D element positioning.

Most analysis applications support IFC, DWG and PDF formats for export, so you can import or place 
the engineer’s structural recommendations into the current ARCHICAD project. ARCHICAD contains 
functions that enable you to view the architectural and structural models separately or in integrated 
form.

See Visualization of Imported Content.

For structural models imported in IFC format, ARCHICAD enables you to utilize and check the 
profiles, materials and other properties suggested by the engineer.

See Imported Properties.

Also, ARCHICAD’s Detect IFC Model Changes feature can display the geometric modifications 
between two versions of a structural project.

(Some structural applications, in turn, can display changes between two versions of an architectural 
model.)

Ask your partner which of these data exchange solutions is supported by his/her analysis 
application, and which of the modeling options and settings will best support your workflow with 
your structural engineer partner.
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